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A Note Regarding Supplemental Files



Supplemental files and examples for this book can be found at http://examples.oreilly.com/9780596008123/. Please use a standard desktop web browser to access these files, as they may not be accessible from all ereader devices.
All code files or examples referenced in the book will be available online. For physical books that ship with an accompanying disc, whenever possible, we’ve posted all CD/DVD content. Note that while we provide as much of the media content as we are able via free download, we are sometimes limited by licensing restrictions. Please direct any questions or concerns to booktech@oreilly.com.

The Developer's Notebook Series



So, you've managed to pick this book up. Cool.
Really, I'm excited about that! Of course, you may
be wondering why these books have the odd-looking, college notebook
sort of cover. I mean, this is O'Reilly, right?
Where are the animals? And, really, do you need
another series? Couldn't this just be a cookbook?
How about a nutshell, or one of those cool hacks books that seem to
be everywhere? The short answer is that a
developer's notebook is none of those
things—in fact, it's such an important idea
that we came up with an entirely new look and feel, complete with
cover, fonts, and even some notes in the margin. This is all a result
of trying to get something into your hands you can actually use.
It's my strong belief that while the nineties were
characterized by everyone wanting to learn everything (Why not? We
all had six-figure incomes from dot-com companies), the new
millennium is about information pain. People don't
have time (or the income) to read through 600-page books, often
learning 200 things, of which only about 4 apply to their current
job. It would be much nicer to just sit near one of the uber-coders
and look over his shoulder, wouldn't it? To ask the
guys that are neck-deep in this stuff why they chose a particular
method, how they performed this one tricky task, or how they avoided
that threading issue when working with piped streams. The thinking
has always been that books can't serve that
particular need—they can inform, and let you decide, but
ultimately a coder's mind was something that
couldn't really be captured on a piece of paper.
This series says that assumption is patently wrong—and we aim
to prove it.
A Developer's Notebook is just what it claims to be:
the often-frantic scribbling and notes that a true-blue alpha geek
mentally makes when working with a new language, API, or project.
It's the no-nonsense code that solves problems,
stripped of page-filling commentary that often serves more as a
paperweight than an epiphany. It's hackery, focused
not on what is nifty or might be fun to do when
you've got some free time (when's
the last time that happened?), but on what you need to simply
"make it work." This
isn't a lecture, folks—it's a
lab. If you want a lot of concept, architecture, and UML diagrams,
I'll happily and proudly point you to our animal and
nutshell books. If you want every answer to every problem under the
sun, our omnibus cookbooks are killer. And if you are into arcane and
often quirky uses of technology, hacks books simply rock. But if
you're a coder, down to your core, and you just want
to get on with it, then you want a Developer's
Notebook. Coffee stains and all, this is from the mind of a developer
to yours, barely even cleaned up enough for print. I hope you enjoy
it...we sure had a good time writing them.
Notebooks Are...



	Example-driven guides
	As you'll see in the 
Organization section, developer's notebooks are built entirely
around example code. You'll see code on nearly every
page, and it's code that does
something—not trivial "Hello
World!" programs that aren't worth
more than the paper they're printed on.

	Aimed at developers
	Ever read a book that seems to be aimed at pointy-haired bosses,
filled with buzzwords, and feels more like a marketing manifesto than
a programming text? We have too—and these books are the
antithesis of that. In fact, a good notebook is incomprehensible to
someone who can't program (don't
say we didn't warn you!), and
that's just the way it's supposed
to be. But for developers...it's as good as it gets.

	Actually enjoyable to work through
	Do you really have time to sit around reading something that
isn't any fun? If you do, then maybe
you're into thousand-page language
references—but if you're like the rest of us,
notebooks are a much better fit. Practical code samples, terse
dialogue centered around practical examples, and even some humor here
and there—these are the ingredients of a good
developer's notebook.

	About doing, not talking about doing
	If you want to read a book late at night without a computer nearby,
these books might not be that useful. The intent is that
you're coding as you go along, knee deep in
bytecode. For that reason, notebooks talk code, code, code. Fire up
your editor before digging in.





Notebooks Aren't...



	Lectures
	We don't let just anyone write a
developer's notebook—you've
got to be a bona fide programmer, and preferably one who stays up a
little too late coding. While full-time writers, academics, and
theorists are great in some areas, these books are about programming
in the trenches, and are filled with instruction, not lecture.

	Filled with conceptual drawings and class hierarchies
	This isn't a nutshell (there, we said it). You
won't find 100-page indices with every method
listed, and you won't see full-page UML diagrams
with methods, inheritance trees, and flow charts. What you will find
is page after page of source code. Are you starting to sense a
recurring theme?

	Long on explanation, light on application
	It seems that many programming books these days have three, four, or
more chapters before you even see any working code.
I'm not sure who has authors convinced that
it's good to keep a reader waiting this long, but
it's not anybody working on
this series. We believe that if
you're not coding within 10 pages,
something's wrong. These books are also chock-full
of practical application, taking you from an example in a book to
putting things to work on your job, as quickly as possible.




Organization



Developer's Notebooks try to communicate different
information than most books, and as a result, are organized
differently. They do indeed have chapters, but
that's about as far as the similarity between a
notebook and a traditional programming book goes. First,
you'll find that all the headings in each chapter
are organized around a specific task. You'll note
that we said task, not
concept. That's one of the
important things to get about these books—they are first and
foremost about doing something. Each of these headings represents a
single lab. A lab is just what it sounds
like—steps to accomplish a specific goal. In fact,
that's the first heading you'll see
under each lab: "How do I do that?"
This is the central question of each lab, and you'll
find lots of down-and-dirty code and detail in these sections.
Some labs have some things not to do (ever played around with
potassium in high school chemistry?), helping you avoid common
pitfalls. Some labs give you a good reason for caring about the topic
in the first place; we call this the "Why do I
care?" section, for obvious reasons. For those times
when code samples don't clearly communicate
what's going on, you'll find a
"What just happened" section.
It's in these sections that you'll
find concepts and theory—but even then, they are tightly
focused on the task at hand, not explanation for the sake of page
count. Finally, many labs offer alternatives, and address common
questions about different approaches to similar problems. These are
the "What about..." sections, which
will help give each task some context within the programming big
picture.
And one last thing—on many pages, you'll find
notes scrawled in the margins of the page. These
aren't for decoration; they contain tips, tricks,
insights from the developers of a product, and sometimes even a
little humor, just to keep you going. These notes represent part of
the overall communication flow—getting you as close to reading
the mind of the developer-author as we can. Hopefully
they'll get you that much closer to feeling like you
are indeed learning from a master.
And most of all, remember—these books are...

            All Lab, No Lecture
         
—Brett McLaughlin, Series Creator

Preface



Who This Book Is For




            ASP.NET 2.0: A Developer's
Notebook is written for programmers who are already
familiar with ASP.NET 1.x (1.0 or 1.1) and who have used a previous
version of Visual Studio .NET (either 2002 or 2003) to build ASP.NET
web applications. Our aim is to introduce you, through a series of
hands-on labs, to the new features of ASP.NET 2.0 using the Visual
Studio 2005 development environment.
In order to get the most out of this book you'll
need a copy of Visual Studio 2005 that supports Visual Basic. You are
encouraged to work your way through the labs, as they are
purposefully small and to the point; however, the complete source
code (along with an Errata) is available on
O'Reilly's web page for this book,
http://www.oreilly.com/catalog/aspnetadn/.

            ASP.NET 2.0: A Developer's
Notebook covers very little of the material that an
experienced ASP.NET 1.x programmer already knows: our goal is to help
you to build on your current knowledge, not to waste your time with
old material.
Tip
If you are not yet familiar with ASP.NET, you may prefer to read
Programming ASP.NET by Jesse Liberty and Dan
Hurwitz, which teaches ASP.NET from the ground up.
As the examples in this book are all written in Visual Basic 2005, C#
programmers will have to do some conversion. However, the syntactical
differences between the two languages are minor and make the
conversion process trivial. For more information, see the
C# and VB.NET Conversion Pocket Reference by
Jose Mojica (O'Reilly).

Similarly, this book does not try to be exhaustive in its treatment
of how you go about building web applications with ASP.NET 2.0 and
the Visual Studio 2005 development environment. Instead, I introduce
you to what is new in ASP.NET 2.0, the development environment and
the class libraries, and to equip you for further exploration of
those areas that are likely to be of particular interest to you.


How This Book Is Organized




            ASP.NET 2.0: A Developer's
Notebook is organized in eight chapters, with each chapter
focusing on a particular set of new features in ASP.NET. In some
chapters, the labs can be read independently of each other; in
others, it is more logical to read through the labs in sequence, when
the material in each lab builds on the previous one. In any case, the
examples are structured so that you can learn the concepts very
quickly by following the steps outlined.
In Chapter 1, I walk you through the new steps
you follow with Visual Studio 2005 to set up ASP.NET 2.0 web
applications, and then highlight some of the changes in the new
development tool. I also discuss some of the most interesting
controls that are new to ASP.NET 2.0. In addition, ASP.NET 2.0 comes
with some neat improvements to the old ways of doing things, such as
cross-page posting, inserting client script into the page, and more.
These new improvements are also covered in this chapter.
In Chapter 2, you will learn about Master
Pages, a new feature supported by ASP.NET for visual page
inheritance, which is similar to Windows Forms inheritance. With
ASP.NET 2.0, you can now create a single Master page that contains
the common elements used by the pages of your site. You can then
create web pages that inherit from the Master page, to enforce a
common look-and-feel across your entire site. In addition to Master
Pages, you will also learn how to use the new navigational controls
in ASP.NET 2.0. These controls, known as SiteMapPath and Menu, allow
you to add navigational links to your site without much coding.
In Chapter 3, you will learn how to create
portal web sites using the Web Parts Framework. Web sites today
contain a wealth of information, so much so that a poorly designed
site can easily overwhelm users. To better help users cope, portal
web sites (such as MSN) often organize their data into discrete units
that support a degree of personalization. Information is organized
into standalone parts and users are allowed to rearrange those parts
to suit their individual working styles. Such personalization also
lets users hide parts that contain information in which they have no
interest. What's more, users can save their settings
so that the site will remember their preferences when they return. In
ASP.NET 2.0, you can use the new Web Parts Framework to build web
portals that offer this kind of modularization of information and
personalization.
In Chapter 4, you will learn to use new
controls that reduce the coding necessary to do data access. Data
access is one of the most common tasks that you're
likely to perform when you write web applications. This is evident in
the number of new data controls that ship with Visual Studio 2005.
One of the most important is the new GridView control, which is a
much improved version of the venerable DataGrid control of previous
versions (the older DataGrid control is still supported in ASP.NET
2.0, though). In addition, ASP.NET 2.0 ships several new data source
controls that make it easier to consume a variety of data sources. In
this chapter, you will learn how to use the various new data
controls—GridView,
DetailsView, and
DataList—together with the new data source
controls, such as SqlDataSource,
ObjectDataSource, and
XmlDataSource. With all these controls, data
access is now much easier than before, and you can spend more time
working on your business logic.
In Chapter 5, you will discover the new
security controls in ASP.NET 2.0 that aim to simplify the life of a
developer. Using these new security controls, you can now perform
user login, registration, changing of password, and more, with no
more effort than dragging-and-dropping controls onto your web form.
Powering these new controls are the Membership APIs, which perform
the mundane tasks of user management without you having to write your
own code. In this chapter, you will learn how the use the new
security controls to secure your site. You will also learn about the
Membership APIs and how they can be used to perform user
administration.
In Chapter 6, you will learn about some of the
productivity improvements in ASP.NET 2.0. For example, in ASP.NET
1.x, because pages are dynamically compiled and cached the first time
a user loads a page, an ASP.NET 1.x web application is typically
slower the first time it is loaded. In ASP.NET 2.0, you can now
precompile a site so that it's already compiled when
the first user links to it. ASP.NET 2.0 also supports fragment
caching, which means that you can cache parts of your page rather
then the entire page. Consuming web services is also made easier with
the automatic generation of a web proxy class based on a WSDL
document. Simply drop a WSDL document into the
App_Code folder, and the web proxy class will be
automatically generated. Finally, ASP.NET 2.0 includes the Client
Callback Manager, which allows you to update your page with
information from the server without performing a postback.
In Chapter 7, you will learn how to create
personalizable web sites using the Profile service. Personalizing
your web site enhances the experiences of your users, by preserving
information about visitors so that it can be reused when they come to
your site again. In ASP.NET 2.0, the new Profile service gives you a
way to store information about your users.
Finally, in Chapter 8, you will learn about how
you can maintain a consistent look-and-feel for your web site using
themes and skins. In this chapter, you will learn about the new
Themes and Skins feature in ASP.NET 2.0 and how you can use it to
maintain a consistent user interface for your application. In
addition, localization in ASP.NET 2.0 has gotten easier with the new
auto-culture handling mechanism. You will learn how to create
applications that support multiple cultures.

Where Can I Learn More?



While I try to show you as many of the new features in ASP.NET 2.0 as
I can, it is not possible to cover them all in the scope of this
book. Microsoft has made many enhancements to Visual Studio 2005 and
ASP.NET 2.0, and often there is more than one way of doing the same
thing.
Thus, the end of each lab includes a section entitled
"Where Can I Learn More?" Here I
will point you to books, magazine articles, online resources, MSDN
articles, and Visual Studio 2005 Help topics where you can find more
detail or obtain another perspective. When I refer to the
MSDN Help Topics, I am generally referring to
the MSDN Library that is available to you through the installed
Visual Studio 2005 Help, or online at http://msdn.microsoft.com/library. The MSDN
Library contains a wealth of resources and should be the first place
you visit if you have a question about a particular feature of
ASP.NET. Online articles are also a very useful way to learn more
about a particular feature of ASP.NET. I would also encourage you to
check out some of the following good magazines where you can read
more about ASP.NET:
	
                  MSDN Magazine
               

	
                  CoDe Magazine
               

	
                  Visual Studio Magazine
               

	
                  .NET Developer Journal
               



Tip
My web site, http://www.developerlearningsolutions.com,
contains a collection of links to articles I have written on .NET.
You can also download sample code from my web site.


What You Need to Use This Book



I am assuming that you are somewhat familiar with how ASP.NET works
in principle, and so in this book I have concentrated on the new
features in ASP.NET 2.0. Also, the code examples in this book are all
written in Visual Basic 2005, so you should be well versed in Visual
Basic to take advantage of this book. If you are a C# programmer,
converting the examples from VB to C# should not take too much
effort. For this task, I suggest you take a look at C# and
VB.NET Conversion Pocket Reference by Jose Mojica,
published by O'Reilly Media, Inc.
You'll want a computer with a version of Visual
Studio 2005 installed that supports Visual Basic, along with some
form of SQL Server (SQL Server Express is fine).
You can also do the labs in this book using the new Visual Studio
Express Editions. Specifically, you'll need Visual
Web Developer 2005 Express Edition.

Conventions Used in This Book



The following typographical conventions are used in this book:
	
                  Plain text
               
	Indicates menu titles, menu options, menu buttons, and keyboard
accelerators (such as Alt and Ctrl). Plain text is also used for the
names of controls, files, classes, interfaces, methods, properties
and other elements when these names are used in conjunction with
their type (e.g., Page class).

	
                  Italic
               
	Indicates new terms, URLs, email addresses, filenames, file
extensions, pathnames, directories, and Unix utilities.

	
                  Constant width
               
	Indicates commands, options, switches, variables, attributes, keys,
functions, types, classes, namespaces, methods, modules, properties,
parameters, values, objects, events, event handlers, XML tags, HTML
tags, macros, the contents of files, or the output from commands.

	
                  Constant width bold
               
	Shows commands or other text that should be typed literally by the
user.

	
                  Constant width italic
               
	Shows text that should be replaced with user-supplied values.



Tip
This icon signifies a tip, suggestion, or general note.

Warning
This icon indicates a warning or caution.

Note

               This icon indicates a Developer's Note.
            


Using Code Examples



This book is here to help you get your job done. In general, you may
use the code in this book in your programs and documentation. You do
not need to contact us for permission unless you're
reproducing a significant portion of the code. For example, writing a
program that uses several chunks of code from this book does not
require permission. Selling or distributing a CD-ROM of examples from
O'Reilly books does require
permission. Answering a question by citing this book and quoting
example code does not require permission. Incorporating a significant
amount of example code from this book into your
product's documentation does
require permission.
We appreciate, but do not require, attribution. An attribution
usually includes the title, author, publisher, and ISBN. For example:
"ASP.NET 2.0: A Developers
Notebook by Wei-Meng Lee. Copyright 2005
O'Reilly Media, Inc.,
0-596-00812-0."
If you feel your use of code examples falls outside fair use or the
permission given above, feel free to contact us at permissions@oreilly.com.

Safari® Enabled




            
[image: image with no caption]

When you see a Safari® enabled icon on the cover of your favorite technology book that means the book is available online through the O'Reilly Network Safari Bookshelf.
Safari offers a solution that's better than e-books.
It's a virtual library that lets you easily search
thousands of top tech books, cut and paste code samples, download
chapters, and find quick answers when you need the most accurate,
current information. Try it for free at http://safari.oreilly.com.

I'd Like to Hear from You



Please send comments, suggestions, and errata to
wei_meng_lee@hotmail.com. You can also visit my web
site at http://www.developerlearningsolutions.com for
a list of articles that I have written on ASP.NET 2.0. Check out the
Code Library section to download sample code for topics on .NET,
ASP.NET 2.0, and the .NET Compact Framework.

Comments and Questions



Please address comments and questions concerning this book to the
publisher:
	O'Reilly Media, Inc.
	1005 Gravenstein Highway North
	Sebastopol, CA 95472
	(800) 998-9938 (in the United States or Canada)
	(707) 829-0515 (international or local)
	(707) 829-0104 (fax)

We have a web page for this book, where we list errata, examples, and
any additional information. You can access this page at:
	
               http://www.oreilly.com/catalog/aspnetadn/
            

To comment or ask technical questions about this book, send email to:
	
               bookquestions@oreilly.com
            

For more information about our books, conferences, Resource Centers,
and the O'Reilly Network, see our web site at:
	
               http://www.oreilly.com
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Chapter 1. What's New?



Within a few short years, ASP.NET has become one of the favorite
tools of web applications developers, and now it's
about to undergo its second major upgrade. Microsoft is making major
improvements to the product based on feedback from its millions of
customers and the company's own experience in
developing and deploying web applications. Moreover, the market for
web development tools has become increasingly competitive with the
rise of open source PHP and Macromedia Flash, both of which have
steadily gained market share.
	Controls
	ASP.NET 2.0 ships with
several new
controls to make the life of a web application developer easier. In
ASP.NET 2.0, there are now new controls that help you to perform data
access, site navigation, login, and personalization using Web Parts.

	Page Framework
	ASP.NET 2.0 supports some useful additions to its Page framework such
as visual inheritance, technically 
                  known as Master Pages. Besides Master
Pages, ASP.NET 2.0 also supports
"theming" through Themes and Skins,
allowing you to maintain a consistent look-and-feel for your web
sites. Another noteworthy feature in ASP.NET is the improved support
for localization, which reduces the amount of work you need to do to
internationalize your web applications.

	Services and APIs
	Behind the various 
                  new controls in ASP.NET 2.0 lie the
foundation services and APIs that do the heavy lifting needed to
support the controls. For example, behind the new Login controls
you'll find the new collection of Membership APIs,
which perform such tasks such as user authentication, registration of
new users, etc. Besides using the new controls, you can directly make
use of these APIs in code.




         Table 1-1 summarizes some of most
important new
features of ASP.NET 2.0.
Table 1-1. Summary of new features in ASP.NET 2.0
	
                     Controls

                  	
                     Page Framework

                  	
                     Services and APIs

                  
	
                     Data Controls


                     Includes controls that simplify the connection to data sources, as
well as the new GridView and DetailsView controls.


                     We will discuss this topic in Chapter 4.

                  	
                     Master Pages


                     Visual page inheritance for Web Forms.


                     We will discuss this topic in Chapter 2.

                  	
                     Membership


                     The core service for user management, such as user creation,
deletion, authentication, retrieval of passwords, etc.


                     We will discuss this topic in Chapter 5.

                  
	
                     Login Controls


                     Contains controls that make web site user management and user
authentication easy and efficient.


                     We will discuss this topic in Chapter 5.

                  	
                     Themes and Skins


                     Maintain consistent look-and-feel for the entire site by using Skins
definitions grouped by themes.


                     We will discuss this topic in Chapter 8.

                  	
                     Role Management


                     Manages the assignment of roles to users, such as add user to role,
delete user from role, enquire if user is in role, etc.


                     We will discuss this topic in Chapter 5.

                  
	
                     Web Parts


                     Provides the infrastructure for creating Web Parts.


                     We will discuss this topic in Chapter 3.

                  	
                     Localization


                     Simplify the steps needed to globalize and localize your web
applications.


                     We will discuss this topic in Chapter 8.

                  	
                     Site Maps


                     Supports the retrieval of site information, as well as display of
site maps.


                     We will discuss this topic in Chapter 2.

                  
	
                     Navigation Controls


                     Contains controls that display site information and menus.


                     We will discuss this topic in Chapter 2.

                  	
                     Compilation


                     Supports dynamic compilation of business logic without the need for
explicit recompilation when the code is changed. Also supports
automatic generation of Web Services proxy class using WSDL.


                     We will discuss this topic in Chapter 6.

                  	
                     Profile


                     Supports the personalization of Web sites through the Profile object.


                     We will discuss this topic in Chapter 7.

                  
	
                     Additional Standard Controls


                     Contains controls such as ImageMap, FileUpload, MultiView, and
TreeView.


                     We will discuss these controls in Chapter 1 and Chapter 2.

                  	
	




This chapter starts with a walkthrough of the steps you now follow to
create a web application with Visual Studio 2005, and then dives into
a few of the coolest new controls and control functionality.
Tip
If the professional editions of Visual Studio 2005 are too expensive
for you, try the Visual Web Developer 2005 Express Edition, a
lightweight, easy-to-use, and easy-to-learn development tool focused
exclusively on web development. It is primarily targeted at hobbyist
developers and students who may find the cost of Visual Studio 2005
prohibitive. At the time of this writing, Microsoft has not yet
announced pricing for the Visual Web Developer 2005 Express Edition
but is widely expected to sell this version for a nominal amount.

Create a New Web Project



The way you create a new web

            
            application project has changed
in Visual Studio 2005. In Visual Studio .NET 2003, you select
File→ New Project on the
Visual Studio menu and then select the kind of project you want to
create (Web, Windows, Windows Services, and so on) in the New Project
Dialog. In Visual Studio 2005, you open a new web project with the
New Web Site... command in the File menu.
Visual Studio 2005 Editor Settings
When you launch Visual Studio 2005 for the first time, you
will be asked to choose a default setting for the IDE. Among the list
of settings available are:
	Web Development Settings

	Visual Basic Development Settings

	Visual C# Development Settings



Depending on which setting you choose, you will get a slightly
different menu setup.

Note

               With Visual Studio 2005, it's now easier
than ever to start building an ASP.NET web application.
You've got to try it to believe it!
            

How do I do that?



To get a feel for how you create a new web application in Visual
Studio 2005, try walking through the following steps. First
we'll open the application, pick a location to host
it for development, and then add a second web form. Finally, we will
see how we can debug the application.
	You can change the IDE settings (listed in Sidebar 1-2
via
Tools→ Import and Export
Settings.... Since this book is all about web development, we
naturally suggest you select Web Development Settings. Launch Visual
Studio 2005. If you selected the Web Development Settings option in
Visual Studio 2005, go to the File menu and select New Web Site...,
as shown at the top of Figure 1-1. If you have
chosen any other setting, go to the File menu and choose
New→ Web Site... (see the
bottom part of Figure 1-1).
[image: Creating a new web site in Visual Studio 2005]

Figure 1-1. Creating a new web site in Visual Studio 2005


	When the New Web Site dialog box appears, select a project
template from the Templates pane. Since we're
creating a blank ASP.NET web site in this lab, select the ASP.NET Web
Site template.

	In the New Web Site dialog, you need to choose a development language
and a place to locate the project. We'll be using
Visual Basic as our language of choice throughout this book, so from
the Language drop-down listbox, select Visual Basic.
Visual Studio 2005 provides four ways to develop a web site. For this
lab, you'll use the File System option. Choose File
System from the Location drop-down list. This
new ASP.NET 2.0 option frees you from
having to use IIS (Microsoft Internet Information Server) for
development. Instead, Visual Studio 2005 provides its own built-in
web server, which it launches when you run the web application. Use
C:\ASPNET20\ as the location of your
application and chap01-WebSite1
as its name. Type the complete
pathname, C:\ASPNET20\chap01-WebSite1, into the
drop-down combo box to the right of the Location box.
Note

                        No more worries about creating virtual directories on your
web server! Visual Studio 2005 comes with a file-based web server for
developing ASP.NET 2.0 applications. Now you can also develop ASP.NET
2.0 web applications on a Windows XP Home Edition PC, which
traditionally does not include IIS.


                     Figure 1-2 shows the completed New Web Site dialog.
[image: Selecting a project language, template, and location]

Figure 1-2. Selecting a project language, template, and location

Tip
For all subsequent examples in this book, you will use
C:\ASPNET20\ as the directory in which to store
your projects.

If you do wish to use IIS for development purposes,
select HTTP from the Location drop-down list and enter a URL for the
application instead, such as http://localhost/chap01-WebSite1.
Order of Installation
If you wish to use
IIS to develop your ASP.NET web applications, you must install IIS
before installing Visual Studio 2005. By default, Windows XP does not
install IIS, and so you need to retrieve your Windows XP Installation
CD and then use Control
Panel→ Add or Remove
Programs→ Add/Remove
Windows Components→
Components: Internet Information Services (IIS) to add IIS yourself.
In the event that you have installed Visual Studio 2005 before
installing IIS, you need to associate IIS with ASP.NET. You can do so
by using the aspnet_regiis utility (located in
C:\WINDOWS\Microsoft.NET\Framework\<version>)
with the -i option, like this:
aspnet_regiis -i


	Once you have selected your template, language, and location, click
OK. Visual Studio creates your project, and the Solution Explorer
should display the files shown in Figure 1-3.
[image: The Solution Explorer]

Figure 1-3. The Solution Explorer


	By default, ASP.NET creates a folder named
App_Data and an initial application page, a Web
Form named Default.aspx with a code-behind page
named Default.aspx.vb (to see the contents of
this file, click the + symbol to the left of Default.aspx icon in the
Solution Explorer).
Switching Between Design View, Source View, and Code-Behind View
In Visual Studio 2005, a Web Form 
                        
                        is displayed in Source View by
default. In Source View, you can modify the various attributes of the
form and the controls contained within it. To switch to Design View,
click on the Design button at the bottom of the screen. In Design
View, you can visually inspect the page and drag and drop controls
onto the form. To view the code-behind of the form, you can simply
double-click on the form and the code-behind will appear. In Code
View, you write your business logic for your application as well as
service the events raised by the various controls on the page. Figure 1-4 shows the three views.
[image: Switching Between the Different Views]

Figure 1-4. Switching Between the Different Views



	To add a new item (such as an 
                     additional Web
Form) to your project, you can right-click the project name and
select a template from the Add New Item... dialog box shown
in
Figure 1-5.
[image: Adding a new item to your web project]

Figure 1-5. Adding a new item to your web project


	Notice that you have the option to "Place code in
separate file." If this option is unchecked, your
code will reside in the same file as your Web Form. For all the
examples in this book, you will place the code in a separate file.
Hence, check the "Place code in separate
file" option. Click Add.



Tip
If you wish to debug your application (by using F5), you need to have
a Web.config file in your project. By default,
if there is no Web.config file when you try to
debug your application, Visual Studio will prompt you to add one.
In Visual Studio 2005 (unlike Visual Studio .NET 2003),
Web.config is not automatically added to your
project. To add a Web.config file yourself,
simply go to the Add New Item... dialog box, and select Web
Configuration File from the "Visual Studio installed
templates" window.


What about...




               ...modifying the code generated by the Visual
Designer? 
               
            
If you look at the code-behind of a Web Form, you
will
realize that the bulk of the user interface code generated by Visual
Studio is no longer visible, as it has been in ASP.NET 1.x. Instead,
you see a partial class:
Partial Class Default_aspx

End Class
You add your business logic to this partial class. Unlike ASP.NET
1.x, where the code-behind contains code generated by the Visual
Designer, ASP.NET 2.0 does not display this section. Instead, at
compile time, the Visual Designer automatically generates the partial
class needed to implement the user interface and merges it with your
code-behind.
The New Partial Keyword
One of the language enhancements in .NET 2.0—available to both
VB2005 and C# 2.0 programmers—is support for

                  
                  partial classes. In a nutshell, partial
classes mean that your class definition can be split into multiple
physical files. Logically, partial classes do not make any difference
to the compiler. During compile time, it simply groups all the
various partial classes and treats them as a single entity.
One of the greatest benefits of partial classes is that they allow a
clean separation of business logic and the user interface (in
particular, the code that is generated by the Visual Studio
Designer). Using partial classes, the UI code can be hidden from the
developer, who usually has no need to access it anyway. Partial
classes also make debugging easier, as the code is partitioned into
separate files. This feature also helps members of large development
teams work on their pieces of a project in separate physical files.


               ...choosing another location for your web
application?
            
Visual Studio 2005 provides four possible 
               locations for a web application. If you
are developing a simple web application (or are just trying out some
of the new features in ASP.NET), the quick and easy way to build the
application is to use the 
               
               File System method. This method is also
useful for developers who do not have a web server (such as IIS)
installed on their machine, or for developers who are using Windows
XP Home Edition as their development workstation.
If you already have a web server installed on your machine and you
want to use it to host your web application, you can choose the Local
IIS method. Doing so allows your web application to be accessed from
other machines during development time.
If your web server is located remotely, such as in a hosting
environment, then you could use the FTP 
               method. Use FTP Sites if
your hosting vendor supports FTP access. Alternatively, you can host
your application on another remote server through HTTP using the
Remote Web Site option. To use this option, the remote server must be
configured with the FrontPage Server Extensions.
Improved Debugging Support in ASP.NET 2.0
In ASP.NET 1.x, you need to explicitly
set a start page
in your project so that a specific page is loaded when you press F5
to debug the application. In ASP.NET 2.0, you can still set a
specific page as the start page if you want. However, you can also
set the start page as the currently selected page (currently selected
either because you're editing it or because you
selected the page in Solution Explorer). This feature saves you the
trouble of setting a start page when you just want to debug a page
you're working on at the moment.
This option is configurable via the Start Options item in the project
Property Pages dialog (right-click a project name in Solution
Explorer and then select Property Pages), as shown in see Figure 1-6.

[image: The project Property Pages]

Figure 1-6. The project Property Pages


Where can I learn more?



Visit the Visual Studio 2005 home page at http://lab.msdn.microsoft.com/vs2005/ for
information on the latest changes to Visual Studio 2005.
If you prefer to use the Visual Web Developer 2005 Express Edition,
head over to http://lab.msdn.microsoft.com/express/vwd/default.aspx
for information on how to download a trial copy.



Use Multiple Languages



Unlike ASP.NET 1.x, which requires 
            that
you use the same language throughout a web application, ASP.NET 2.0
lets you vary your languages from page to page within a project.
Note

               You're no longer restricted to using a
single language for your web applications.

Tip
While support for multiple languages is a useful feature, developers
should use it in moderation (and only if necessary). Going with
multiple languages in a single project is likely to increase the
effort required in maintaining the project, particularly if the
application ends up being maintained by someone
who's not familiar with all the languages used.


            Figure 1-7 shows a project with three pages, each
of which is programmed with a different language: VB.NET
(Default.aspx), C#
(Default2.aspx), or VJ#
(Default3.aspx).
Tip
VJ# does not support code-behind pages, so none appear for
Page3.aspx in the Solution Explorer window.

[image: A project with pages using different languages]

Figure 1-7. A project with pages using different languages

How do I do that?



To verify that you can really mix languages in an ASP.NET 2.0 web
application, in this lab you will create an application that uses two
languages: VB.NET and C#.
	Using the project created in the last lab, add a new Web Form by
right-clicking the project name in Solution Explorer and then
selecting Add New Item.... Select Web Form from the list of installed
templates.

	In the Add New Item dialog, you can
choose the language you want to use, as shown in Figure 1-8. ASP.NET 2.0 supports three languages: VB2005,
C#, and VJ#. Use the default name of
Default2.aspx and choose the C# language. Click
Add.
[image: Choosing the language to use]

Figure 1-8. Choosing the language to use


	In the Code View of Default.aspx, code the
following:
Protected Sub Page_Load(ByVal sender As Object, _
                        ByVal e As System.EventArgs) _
                        Handles Me.Load
    Page.Title = "Page written in Visual Basic"
End Sub

	In the Code View of Default2.aspx, code the
following:
void Page_Load(object sender, EventArgs e)
{
    Page.Title = "Page written in C#";
}

	To test the application, select Default.aspx in
Solution Explorer and press F5. In IE, note the title of the window.
Now, change the URL to load Default2.aspx. Figure 1-9 shows the effect of loading the two forms.



[image: Loading two forms in an application written in two different languages]

Figure 1-9. Loading two forms in an application written in two different languages


What about...




               ...using other .NET-supported languages such as
C++, Python, or
Perl?
               
               
               
            
Visual Studio 2005 will support only VB2005, C#, and VJ# for web
development. The other languages are, however, available for other
types of non-web projects.

Where can I learn more?



There is a good discussion on mixing languages in a .NET project at
http://weblogs.asp.net/dreilly/archive/2003/05/17/7164.aspx.
So before you go ahead and write your next ASP.NET web application
using both VB.NET and C# (or J#), check out what other developers
have to say.
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